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Do najważniejszych chorób bobiku należą askochytoza powodowana przez grzyb Ascochyta fabae oraz czekoladowa 
plamistość powodowana przez grzyb Botrytis fabae. Przebadano patogeniczność izolatów A. fabae i B. fabae wobec 
sześciu odmian bobiku. Zastosowano technikę odciętych liści. Liście inokulowano zarodnikami piknidialnymi i koni-
dialnymi badanych patogenów. Po inkubacji określano rozmiary plam nekrotycznych wytwarzanych przez patogeny. 
Stwierdzono istotne zróżnicowanie patogeniczności izolatów obu grzybów. Odmiany wykazały zróżnicowaną odpor-
ność na askochytozę i czekoladową plamistość. Zróżnicowanie odporności odmian na czekoladową plamistość było 
mniejsze niż odporności na askochytozę. Opisano możliwość wykorzystania programu do analizy obrazu ImageJ do 
pomiaru powierzchni plam nekrotycznych. 

Słowa kluczowe: analiza obrazu, askochytoza, czekoladowa plamistość, odporność, Vicia faba 

The most important diseases of the faba bean include Ascochyta blight caused by the fungus Ascochyta fabae and choc-
olate spot caused by the fungus Botrytis fabae. The pathogenicity of isolates of A. fabae and B. fabae was investigated 
against six cultivars of faba bean. The technique of detached leaves was used. The leaves were inoculated with pycnidi-
al and conidial spores of the pathogens tested. After incubation, the sizes of the necrotic spots produced by the patho-
gens were determined. Significant variation in the pathogenicity of isolates of both fungi was found. The varieties 
showed differential resistance to Ascochyta blight and chocolate spot. The variation in resistance of cultivars to choco-
late spot was lower than resistance to Ascochyta blight. The possibility of using the ImageJ image analysis software to 
measure the surface of necrotic lesions was described.    

Keywords: Ascochyta blight, chocolate spot, image analysis, resistance, Vicia faba 

Wstęp 

Bobik (Vicia faba L. ssp. minor) należy do 
bobowatych grubonasiennych (Fouad i in., 2013). 
Uprawiany jest na nasiona, które mają wysoką 
zawartość białka (25-30%) i mogą stanowić suro-
wiec do produkcji białkowych pasz dla zwierząt 
(Grela i Czech, 2019). Dodatkową zaletą uprawy 
bobiku jest poprawa struktury gleby poprzez jej 
rozluźnianie oraz wzbogacanie w substancję orga-
niczną. Dzięki uprawie bobiku gleba wzbogacana 
jest w azot asymilowany przez bakterie brodawko-
wate. Ma to szczególne znaczenie w uprawie eko-
logicznej, w której nie stosuje się sztucznych na-
wozów azotowych. 

Powierzchnia uprawy bobiku w Polsce wyno-
siła ok. 35 tys. hektarów w roku 2022 (Panek 
2022). W ostatnich 10 latach wzrosła prawie  
4-krotnie. Powierzchnia ta jest niższa niż po-
wierzchnia uprawy łubinów, grochu siewnego 
i soi. Wynika to przede wszystkim z wysokich 
wymagań bobiku co do warunków glebowych 
oraz dużych potrzeb wodnych w okresie od two-

rzenia pąków do wykształcania strąków. Bobik 
jest również silnie porażany przez szkodniki 
(mszyce, oprzędziki, strąkowiec bobowy) i pato-
geny wywołujące choroby grzybowe. Największe 
znaczenie w uprawach bobiku mają askochytoza 
powodowana przez grzyb Ascochyta fabae Speg. 
(teleomorfa Didymella fabae Jellis & Punith) oraz 
czekoladowa plamistość powodowana przez grzyb 
Botrytis fabae Sard. (Díaz-Ruiz i in., 2009; Kaur 
i in., 2014; Zakrzewska, 2004, 1988). Askochyto-
za jest powszechną chorobą w uprawach bobiku 
powodując straty plonu do 90% u wrażliwych od-
mian, gdy warunki środowiskowe sprzyjają roz-
wojowi choroby (Hanounik i Robertson, 1989). 
Grzyb infekuje wszystkie nadziemne części roślin, 
w tym nasiona (Sillero i in., 2010).  

Odporność bobiku na askochytozę (A. fabae) 
jest cechą złożoną. Jest on kontrolowana zarówno 
przez pojedyncze geny główne, jak i poligenicznie 
(Avila i in., 2004; Kohpina i in., 2000a; Ondřej 
i Huňady, 2007; Román i in., 2003; Sillero i in., 
2010). Zidentyfikowano również geny związane 
z odpornością zarówno liści, jaki i łodyg, a także 

mailto:t.goral@ihar.edu.pl
https://orcid.org/0000-0001-9130-6109


66  

BIULETYN IHAR Nr 299 / 2023 
T. Góral 

grupy genów determinujące odporność jedynie 
liści lub łodyg (Kharrat i in., 2006). Dodatkowo 
stwierdzono obecność QTL odporności efektyw-
nych przeciwko różnym izolatom A. fabae, ale 
także QTL efektywne tylko wobec pojedynczych 
izolatów (Avila i in., 2004). Wskazuje to na po-
trzebę stosowania szerokiego spektrum izolatów 
A. fabae do testowania odporności bobiku. 
W związku z powyższym niektórzy badacze suge-
rują istnienie ras patogenu, jednakże nie jest to w 
pełni udokumentowane (Díaz-Ruiz i in., 2009; 
Tivoli i in., 2006). W populacji A. fabae identyfi-
kuje się raczej grupy patogeniczności w zależności 
od nasilenia objawów choroby powodowanej 
przez izolaty na zestawie odmian o zróżnicowanej 
odporności (Blake i in., 2022). Rozmnażanie 
płciowe pozwala na powstanie nowych kombina-
cji wirulencji, co wiąże się z możliwością reakcji 
patogenu na selekcję wywieraną przez wprowa-
dzenie genów oporności gospodarza (Ozkilinc 
i in., 2015; Rubiales i Trapero-Casas, 2002). 

W przypadku B. fabae wywołującego czekola-
dową plamistość nie obserwuje się tego poziomu 
specjalizacji. Stopień odporności bobiku na tę 
chorobę jest niski i zidentyfikowano jedynie nie-
liczne źródła odporności (Gela i in., 2022; Sillero 
i in., 2010). 

Badanie odporności bobiku na askochytozę 
i czekoladową plamistość jest pracochłonne i wy-
maga stworzenia odpowiednich warunków prowo-
kacyjnych dla rozwoju tych chorób (Zakrzewska, 
2004, 1988). Przyspieszenie procesu selekcji ge-
notypów odpornych można uzyskać wykorzystu-
jąc technikę odciętych liści (Herath i in., 2001; 
Kohpina i in., 2000b; Tivoli i in., 2006). W przy-
padku askochytozy bobiku należy brać pod uwa-
gę, że reakcja liści i łodyg na infekcję grzybem A. 
fabae może być różna (Avila i in., 2004). 
W związku z tym Kohpina i in., (2000b) proponu-
ją używanie również fragmentów łodyg w celu 
uzyskania bardziej wiarygodnych wyników poka-
zujących odporność genotypów bobiku na asko-
chytozę. Ze złożoności reakcji bobiku na askochy-
tozę wynika, że korelacja wyników uzyskanych 
w warunkach laboratoryjnych i polowych nie zaw-
sze jest wysoka. Wpływa na to wspomniana po-
wyżej różna odporność liści oraz łodyg na infekcję 
A. fabae, ale także fakt, że grzyb poraża również 
strąki (Zakrzewska, 2004). Na rozwój choroby 
w warunkach polowych wpływ ma również dłu-
gość łodygi oraz typ kwiatostanu (Jellis i in., 
1985; Pritchard i in., 1989; Zakrzewska, 2004). 
W przypadku czekoladowej plamistości uzyskiwa-
no zadowalającą zgodność wyników testów na 
odciętych liściach i testów w warunkach polowych 
(Zaki, 2010). Zgodność ta była najmniejsza dla 
genotypów o średniej odporności na tę chorobę 
(Bouhassan i in., 2004; Tivoli i in., 2006; Villegas-
Fernández i in., 2011). 

Celem pracy było przebadanie patogeniczno-
ści izolatów A. fabae i B. fabae oraz odporności 
odmian bobiku na choroby powodowane przez te 
patogeny z wykorzystaniem techniki odciętych 
liści. Testowano również możliwość wykorzysta-
nia oprogramowania do analizy obrazu do precy-
zyjnej i zautomatyzowanej oceny nasilenia po-
wyższych chorób na odciętych liściach bobiku. 

Materiał i metody 

Przeprowadzono ocenę patogeniczności izola-
tów grzybów Ascochyta fabae i Botrytis fabae 
wobec odmian bobiku. Do badań zastosowano 
sześć odmian bobiku: Bobas – odmiana tradycyj-
na, wysokotaninowa; Albus, Amulet, Kasztelan – 
odmiany tradycyjne, niskotaninowe; Granit, Opti-
mal – odmiany samokończące, wysokotaninowe. 
Nasiona bobiku uzyskano z firm hodowlanych 
(Albus, Amulet, Granit, Kasztelan – Hodowla Ro-
ślin Strzelce; Bobas, Optimal – DANKO Hodowla 
Roślin).  

Izolaty A. fabae i B. fabae zostały uzyskane 
z liści wykazujących objawy askochytozy i czeko-
ladowej plamistości oraz z nasion z objawami po-
rażenia (Tabela 1). Izolaty przechowywane są 
w kolekcji Zakładu Biologii Stosowanej IHAR-
PIB. 

W celu uzyskania zarodników grzyby A. fabae 
i B. fabae hodowane były na pożywce z PDA 
(agar glukozowo-ziemniaczany) (Carl Roth 
GmbH, Karlsruhe, Niemcy) z dodatkiem mączki 
z nasion bobiku (Zakrzewska, 2004). Szalki na-
świetlane były światłem UV (black light, 360 nm) 
w cyklu 12/12h w celu stymulacji zarodnikowania 
(Rys. 1). Powierzchnię szalek, na których obser-
wowano zarodnikowanie grzybów, zmywano wo-
dą destylowaną. Powstałą zawiesinę filtrowano 
przez gazę w celu usunięcia fragmentów grzybni. 
Stężenie zawiesiny piknidiospor A. fabae ustalono 
na 100 000 zarodników w 1 mililitrze, natomiast 
konidiospor B. fabae na 500 000 zarodników 
w 1 mililitrze. Pomiary stężenia zarodników wy-
konano za pomocą komory hematologicznej Tho-
ma (Carl Roth GmbH, Karlsruhe, Niemcy). Dla 
wszystkich badanych izolatów obu gatunków usta-
lono takie same stężenia zarodników. 

Do oceny patogeniczności izolatów i odporno-
ści odmian zastosowano metodę odciętych liści 
(Walentyn-Góral i Góral, 2011; Góral i Walentyn-
Góral, 2012). Wysterylizowane liście bobiku 
umieszczano na kwadratowych szalkach Petriego 
o wymiarze 12,5 × 12,5 cm (Bionovo, Legnica, 
Polska). Pożywkę stanowił agar wodny (Carl Roth 
GmbH, Karlsruhe, Niemcy) z dodatkiem 100 mg 
benzymidazolu (Merck Life Science Sp. z o.o., 
Poznań, Polska) na litr. Każdy z listków inokulo-
wano kroplą (50 ml) zawiesiny zarodników 
A. fabae lub B. fabe. Kroplę umieszczano na środ-
ku listka w miejscu nakłutym igłą. Na każdym 
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Tabela 1  
Table 1  

Lista izolatów Ascochyta fabae i Botrytis fabae  
List of isolates of Ascochyta fabae and Botrytis fabae 

Gatunek 
Species 

Izolat 
Isolate 

Żródło 
Source 

Odmiana 
Cultivar 

Rok izolacji 
Isolation year 

A. fabae AF 5-1 nasiona / seeds Titus * 

A. fabae AF 5-2 nasiona / seeds Titus * 

A. fabae AF 6-1 nasiona / seeds Amulet 2009 

A. fabae AF 6-2 nasiona / seeds Amulet 2009 

A. fabae AF 7-1 liście / leaves Kasztelan 2012 

A. fabae AF 7-3 liście / leaves Granit 2012 

A. fabae AF 8-1 liście / leaves Bobas 2013 

A. fabae AF 8-2 liście / leaves Amulet 2013 

A. fabae AF 15-1 nasiona / seeds Albus 2017 

A. fabae AF 15-4 nasiona / seeds Granit 2017 

B. fabae BF 1 liście / leaves Optimal 2017 

B. fabae BF 2 liście / leaves Optimal 2017 

B. fabae BF 3 liście / leaves Granit 2017 

B. fabae BF 4 liście / leaves Granit 2017 

* – nasiona przechowywane w zamrażarce, zebrane w roku 2004 
* – seed stored in refrigerator, collected in 2004 

Rys. 1. Izolat Ascochyta fabae rosnący na pożywce PDA z mączką z nasion bobiku (z lewej); piknidiospory A. fabae 
(z prawej) 

Fig. 1. Isolate of Ascochyta fabae growing on a PDA medium with faba bean seed meal (left); pycnidispores of A. fabae 
(right) 

liściu inokulowano 4-5 listków. Szalki z liśćmi 
inkubowane były w komorze hodowlanej (Sanyo 
Electric, Moriguchi, Japonia) w temperaturze  
20°C. Długość dnia wynosiła 12h. Po pojawieniu 
się objawów wykonano pomiary wielkości plam 
nekrotycznych w 5 terminach (7, 10, 14, 16, 21 
dni po inokulacji). Wyliczono średnią powierzch-
nię plamy dla każdego liścia. W terminie 21 dpi 
wykonano zdjęcia porażonych liści. Dla każdego 
z patogenów przeprowadzono dwa doświadczenia 
infekcyjne w dwóch powtórzeniach. 

Analiza statystyczna została wykonana za po-
mocą pakietu XLSTAT Life Science (Version 
2021.3.1.1177, Lumivero, Denver, CO, USA). 

Przeprowadzono analizę wariancji dla średniej 
powierzchni plam nekrotycznych powodowanych 
przez A. fabae i B. fabae (procedura XLSTAT: 
ANOVA). Czynniki stanowiły: izolat, odmiana 
oraz termin pomiaru. Średnie dla odmian i izola-
tów porównywano testem wielokrotnych porów-
nań NIR Fishera.  

Na wybranych zdjęciach dokonano pomiaru 
powierzchni plam za pomocą programu do analizy 
obrazu ImageJ (https://imagej.net) (National Insti-
tutes of Health, Bethesda, MD, Stany Zjednoczo-
ne. oraz the Laboratory for Optical and Computa-
tional Instrumentation, University of Wisconsin, 
Madison, WI, Stany Zjednoczone) (Scheider i in., 
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2012). Celem tych pracy było sprawdzenie możli-
wości wykorzystania analizy obrazu do oceny 
wielkości plam nekrotycznych na liściach bobiku. 

Po otwarciu obrazu liścia (format TIFF, GIF, 
JPEG, BMP i inne) przeprowadzono wstępne ko-
rekty obrazu (np. Image > Adjust > Brightness/
Contrast, Image > Adjust > Color Balance). Na-
stępnie określono skalę pomiarową obrazu w celu 
uzyskania rzeczywistej powierzchni mierzonej 
plamy nekrotycznej (Anlayze > Set Scale). Zazna-
czono plamę nekrotyczną, której powierzchnię 
mierzono za pomocą polecenia Image > Adjust > 
Color Threshold. Wyróżniony obszar obrysowano 
używając polecenia Wand Tool (ikona na pasku 
ikon programu ImageJ). Opcje Wand Tool można 
modyfikować poleceniem Edit > Options > Wand 
Tool. Powierzchnię zaznaczonego obszaru 
obliczono używając polecenia Analyze > Analyze 
Particles. Cały proces można zautomatyzować 
nagrywając makro obejmujące powyższe pole-
cenia (Plugins > Macros > Record).  

Wyniki i Dyskusja 

Wszystkie badane izolaty A. fabae, B. fabae 
wykazały patogeniczność wobec badanych od-
mian bobiku. Objawy w postaci nekroz pojawiały 
się około 7 dni po inokulacji. Następnie nekrozy 
powiększały się, w niektórych przypadkach obej-

mując całą powierzchnię pojedynczego listka 
(Rys. 2). Powierzchnia nekroz wywarzanych przez 
B. fabae była przeciętnie 3-krotnie większa niż 
powodowanych przez A. fabae. Na plamach ne-
krotycznych powstałych na liściach inokulowa-
nych A. fabae tworzyły się piknidia, uwalniające 
zarodniki piknidialne (rys. 2D).  

Patogeniczność izolatów A. fabae była zróżni-
cowana (Tab. 2, Rys. 3). Na podstawie wielkości 
plam nekrotycznych wyróżnione zostały dwie gru-
py izolatów. Pierwsza obejmowało 4 izolaty o wy-
sokiej patogeniczności: 15-4, 15-1, 7-3, 8-2. Naj-
wyższą patogeniczność wykazały izolaty 15-4 i 15
-1 uzyskane w roku 2015 z porażonych nasion 
bobiku z doświadczenia polowego w Radzikowie. 
Izolaty 7-3 i 8-2 uzyskano z porażonych liści ze-
branych w latach 2012 i 2013. Druga grupa obej-
mowała 6 izolatów o istotnie niższej patogenicz-
ności, Różnice między nimi nie były istotne staty-
stycznie. Izolaty A. fabae cechują się dużym zróż-
nicowaniem agresywności wobec bobiku (Blake i 
in., 2022). Wiąże się to z faktem, że A. fabae jest 
gatunkiem heterotalicznym i do wytworzenia się 
pseudotecjów i zarodników workowych wymaga-
na jest obecność dwóch typów kojarzeniowych 
MAT-1 i MAT-2 (Kaiser i in., 2007). 

Odmiany bobiku wykorzystane do badań na 
odciętych liściach różniły się istotnie statystycznie 

Rys. 2. A. Plamy nekrotyczne na liściu bobiku (odmiana Kasztelan) powstałe na skutek inokulacji punktowej zarodnika-
mi grzyba A. fabae, izolat AF 15-5; B. Plama nekrotyczna na liściu bobiku odmiany Kasztelan z tworzącymi się piknidia-
mi grzyba A. fabae, izolat AF 5-2; C. Plama nekrotyczna na liściu bobiku (odmiana Amulet) powstała na skutek inokula-
cji punktowej zarodnikami grzyba B. fabae, izolat BF-1; D. Piknidia grzyba A. fabae na liściu bobiku uwalniające pikni-

diospory.  
Fig. 2. A. Necrotic lesions on faba bean leaves (cultivar Kasztelan) caused by A. fabae isolate AF15-5 after point inocula-
tion with pycnidiospores; B. Necrotic lesion on faba bean cultivar Kasztelan with formatting pycnidia of A. fabae, isolate 
AF5-2; C. Necrotic lesion on faba bean leaves (cultivar Amulet) caused by B. fabae after point inoculation with conidio-

spores; D. Pycnidia of A. fabae on a faba bean leaves releasing pycnidiospores.  
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Tabela 2 
Table 2  

Analiza wariancji powierzchni plam nekrotycznych wytwarzanych przez izolaty A. fabae i B. fabae na sześciu odmia-
nach bobiku 

Analysis of variance of area of necrotic lesions produced by A. fabae and B. fabae isolates on six cultivars of faba bean 

Źródło zmienności 
Source of variation   

Ascochyta fabae  
(10 izolatów / 10 izolates)  

Botrytis fabae  
(4 izolaty / 4 isolates)  

F Pr > F F Pr > F 

Odmiana / Cultivar 10,037 0,000 3,570 0,005 

Izolat / Isolate 19,557 0,000 55,716 0,000 

Termin / Date 62,114 0,000 153,423 0,000 

Odmiana × Izolat 
Cultivar × isolate 

1,971 0,001 3,723 0,000 

Odmiana × date 
Cultivar × experiment 

2,137 0,064 0,857 0,576 

Izolat × date 
Izolate × experiment 

6,801 0,000 10,649 0,000 

Rys. 3. Zróżnicowanie agresywności izolatów A. fabae wobec sześciu odmian bobiku określone z wykorzystaniem techni-
ki odciętych liści. Izolaty oznaczone tą samą literą nie różnią się istotnie statystycznie dla α = 0,05 (analiza wariancji, test 

NIR Fishera)  
Fig. 3. Pathogenicity of isolates of A. fabae towards six faba bean cultivars evaluated using detached leaves technique. 
Isolates marked with the same letter are not significantly different at α = 0.05 (analysis of variance, Fisher’s LSD test) 

pod względem odporności na askochytozę powo-
dowaną przez 4 izolaty o najwyższej patogenicz-
ności (Tab. 3, Rys. 4). Najwyższą odporność wy-
kazał odmiana Bobas. Z tym że nie różniła się ona 
istotnie od odmiany Optimal (SK). 

Najbardziej podatna była odmiana Albus. Od-
miany Kasztelan, Granit (SK) i Amulet były mniej 
podatne i nie różniły się istotnie. Odmiany samo-
kończące bobiku Granit i Optimal wykazały śred-
nią lub niską podatność na porażenie odciętych 
liści askochytozą. Tymczasem w warunkach natu-
ralnej infekcji w polu były one najsilniej porażane 
askochytozą bobiku (Boros i in. 2014; T. Góral 
niepublikowane). Podobne wyniki uzyskała Za-
krzewska (2004) porównując odporność form tra-
dycyjnych i samokończących form bobiku po ino-
kulacji A. fabae w kilkuletnich doświadczeniach 
polowych. Otrzymane wyniki mogą sugerować, że 
nie ma bezpośredniego wpływu genu determinują-
cego kwiatostan szczytowy (Vf_TFL1) na odpor-

ność bobiku na askochytozę (Avila i in., 2007). 
Zwiększona podatność odmian samokończących 
na askochytozę w warunkach polowych wynika 
raczej ze znacznie mniejszej długości łodygi tych 
odmian (około 30-40 cm wg danych COBORU) 
(Jellis i in., 1985; Pritchard i in., 1989; Zakrzew-
ska, 2004). 

Patogeniczność izolatów B. fabae była rów-
nież zróżnicowana (Tab. 1, Rys. 5). Na podstawie 
wielkości plam nekrotycznych wyróżnione zostały 
dwie grupy izolatów. Pierwsza obejmowało 2 izo-
laty o wysokiej patogeniczności: BF 3, BF 1. Dru-
ga grupa obejmowała 2 izolatów o istotnie niższej 
patogeniczności: BF 2 i BF 4. Różnice między 
izolatami w obu grupach nie były istotne staty-
stycznie. 

Odmiany bobiku różniły się istotnie staty-
stycznie pod względem odporności na czekolado-
wą plamistość powodowaną przez dwa izolaty 
o najwyższej patogeniczności (Tab. 2, Rys. 6). 
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Tabela 3 
Table 3  

Analiza wariancji powierzchni plam nekrotycznych wytwarzanych przez izolaty A. fabae i B. fabae na sześciu odmia-
nach bobiku 

Analysis of variance of area of necrotic lesions produced by A. fabae and B. fabae isolates on six cultivars of faba bean 

Ascochyta fabae (4 izolatów / 4 izolates) Botrytis fabae (2 izolaty / 2 isolates) Źródło zmienności 
Source of variation  F Pr > F F Pr > F 

Odmiana / Cultivar 6,963 0,000 2,634 0,036 

Izolat / Isolate 1,223 0,309 0,183 0,670 

Termin / Date 58,043 0,000 110,024 0,000 

Odmiana × Izolat 
Cultivar × Isolate 

1,177 0,314 6,116 0,000 

Odmiana × Termin 
Cultivar × Date 

1,817 0,123 0,711 0,710 

Izolat × Termin 
Isolate × Date 

0,089 0,966 0,492 0,615 

Rys. 4. Odporność odmian bobiku na porażenie 4 izolatami A. fabae określona z wykorzystaniem techniki odciętych 
liści. Odmiany oznaczone tą samą literą nie różnią się istotnie statystycznie dla α = 0,05 (analiza wariancji, test NIR 

Fishera) 
Fig. 4. Resistance of fabae bean cultivars to 4 isolates of A. fabae evaluated using detached leaves technique. Cultivars 

marked with the same letter are not significantly different at α = 0.05 (analysis of variance, Fisher’s LSD test) 

Rys. 5. Zróżnicowanie agresywności izolatów B. fabae wobec sześciu odmian bobiku określone z wykorzystaniem techni-
ki odciętych liści. Izolaty oznaczone tą samą literą nie różnią się istotnie statystycznie dla α = 0,05 (analiza wariancji, test 

NIR Fishera) 
Fig. 5. Pathogenicity of isolates of B. fabae towards six faba bean cultivars evaluated using detached leaves technique. 
Isolates marked with the same letter are not significantly different at α = 0.05 (analysis of variance, Fisher’s LSD test) 
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Rys. 6. Odporność odmian bobiku na porażenie 2 izolatami B. fabae określona z wykorzystaniem techniki odciętych 
liści. Odmiany oznaczone tą samą literą nie różnią się istotnie statystycznie dla α = 0,05 (analiza wariancji, test NIR 

Fishera) 
Fig. 6. Resistance of fabae bean cultivars to 2 isolates of B. fabae evaluated using detached leaves technique. Cultivars 

marked with the same letter are not significantly different at α = 0.05 (analysis of variance, Fisher’s LSD test) 

Najwyższą odporność wykazały odmiany Optimal 
(SK) i Kasztelan, najniższą – odmiany Amulet 
i Albus. Zróżnicowanie odporności odmian na 
czekoladową plamistość było jednakże niższe niż 
obserwowane dla askochytozy (Tab. 2). Potwier-
dzają to również kilkuletnie obserwacje występo-
wania czekoladowej plamistości w warunkach 
polowych w Radzikowie (Boros i in. 2014; T. Gó-
ral niepublikowane). W latach o dużym nasileniu 
czekoladowej plamistości większość odmian pora-
żana była w podobnym stopniu. Wyróżniały się 
jedynie odmiany samokończące, na których nasi-
lenie choroby (oceniane jako stopień porażenia 
liści na całej roślinie) było wyższe. Wyniki publi-
kowanych badań również pokazują, że istnieje 
małe zróżnicowanie odporności genotypów bobi-
ku na czekoladową plamistość (Sillero i in., 2010). 
Problemem w hodowli odpornościowej jest brak 
dobrych źródeł odporności bobiku na tę chorobę. 
Większość zidentyfikowanych genotypów odpor-
nych pochodzi z andyjskich regionów Ameryki 
Południowej i nie jest dostosowana na warunków 
europejskich (Bond i in., 1994; Maalouf i in., 
2016). 

Na rysunku 7 przedstawiono kolejne etapy 
pomiaru powierzchni plamy nekrotycznej opisane 
w rozdziale Materiał i Metody. Opisany proces 
pomiaru stanowi jedynie przykład wykorzystania 
programu ImageJ. Można go modyfikować wyko-
rzystując rozbudowane opcje oprogramowania, 
dostosowując je do własnych potrzeb (Abd-El-
Haliem, 2012; Mutka i in., 2015). Stewart i in. 
(2016) opracowali makro do programu ImageJ do 
oceny nasilenia septoriozy paskowanej (sprawca 
Zymoseptoria tritici) na liściach pszenicy. Dla 
każdego liścia makro umożliwiało pomiar całko-
witej powierzchni liścia, całkowitej powierzchni 
nekrozy, liczby piknidiów, średnią wielkość pikni-

dium oraz tzw. odcień szarości piknidium. Ta 
ostatnia cecha oznacza intensywność produkcji 
melaniny przez izolaty Z. tritici, który to związek 
pełni istotną znaczenie dla wirulencji patogenu 
(Lendenmann i in., 2014). Elliott i in. (2022) po-
równywali metody analizy obrazu za pomocą Ima-
geJ oraz uczenia maszynowego do oceny poraże-
nia manioku przez bakterią Xanthomonas. Autorzy 
stwierdzili, że obie metody precyzyjnie rozróżnia-
ły i określały ilościowo różne typy zmian powodo-
wanych przez Xanthomonas na liściach manioku. 
Metoda ImageJ była bardziej przydatna do analizy 
mniejszych zestawów danych, ponieważ wymaga-
ła tworzenia przez użytkownika maski dla każde-
go obrazu.  

Uzyskanie precyzyjnych pomiarów wymaga 
ujednolicenia wykonywanych zdjęć liści z obja-
wami chorobowymi. Metodyka opisana jest na 
przykład w pracy Bartosiaka (2020), dotyczącej 
oceny porażenia liści siewek pszenicy inokulowa-
nej grzybem Parastagonospora nodorum. W swo-
jej pracy Bartosiak (2020) proponuje również au-
tomatyzację oceny objawów chorobowych za po-
mocą aplikacji w języku Phyton. Jest to aplikacja 
stworzona specjalnie do celów oceny porażenia 
liści i przyspiesza oraz ułatwia pracę w porówna-
niu do dość skomplikowanego programu ImageJ. 
Podobnie Alheeti i in. (2021) wskazali, że użycie 
ImageJ do oceny porażenia liści przez dwa pato-
geny grzybowe jest bardziej pracochłonne niż po-
równywanej przez autorów aplikacji Leaf Doctor 
(darmowa aplikacja na iPhone’a) (Pethybridge 
i Nelson, 2015). Rozwiązaniem tego problemu 
może być opracowywanie wtyczek (plug-in) do 
programu ImageJ. Przykładem jest wtyczka 
HTPheno opracowana w Leibniz Institute of Plant 
Genetics and Crop Plant Research (IPK) (http://
htpheno.ipk-gatersleben.de/) (Hartmann i in., 

http://htpheno.ipk-gatersleben.de/
http://htpheno.ipk-gatersleben.de/
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Rys. 7. Pomiar powierzchni plamy nekrotycznej przy użyciu programu ImageJ. A. Nekroza na liściu bobiku spowodo-
wana przez grzyb A. fabae; B. Wyróżnianie obszaru plamy; C. Obrys wyróżnionego obszaru; D. Pomiar powierzchni 

plamy 
Fig. 7. Necrotic area measurement using ImageJ software. A. Necrotic lesion on faba bean leaf caused by A. fabae; B. 

Highlighting necrotic lesion; C. Outline of the highlighted area; D. Measuring the area of the lesion. 

2011). Wtyczka to może być wykorzystywana do 
zautomatyzowanej analizy obrazu w wysokow-
ydajnym fenotypowaniu roślin. 

Podsumowanie wyników 

1) Zróżnicowanie patogeniczności izolatów A. 
fabae i B. fabae wobec badanych odmian bo-
biku było istotne statystycznie. 

2) Odmiany bobiku wykazały istotną statystycz-
nie zróżnicowaną odporność na askochytozę 
(A. fabae) i czekoladową plamistość (B. fa-
bae). 

3) Wyniki analizy wariancji pokazały, że zróżni-
cowanie odporności odmian na czekoladową 
plamistość było mniejsze niż odporności na 
askochytozę. 

4) Wykonane analizy obrazu pokazują przydat-
ność oprogramowania ImageJ do oceny pora-
żenia liści przez grzyby patogeniczne dla bo-
biku. 

 

Badania zrealizowano w ramach Programu Wie-
loletniego „Tworzenie Naukowych Podstaw Po-
stępu Biologicznego i Ochrony Roślinnych Zaso-
bów Genowych jako Źródło Innowacji i Wspiera-
nia Zrównoważonego Rolnictwa i Bezpieczeństwa 
Żywnościowego Kraju” finansowanego przez Mi-
nisterstwo Rolnictwa i Rozwoju Wsi, realizowane-
go w IHAR-PIB w latach 2015-2020. 
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